SunGard Higher Education
4 Country View Road
Malvern, Pennsylvania 19355
United States of America
(800) 522 - 4827

Customer Support Center website
http://connect.sungardhe.com

Distribution Services e-mail address
distserv@sungardhe.com

Other services
In preparing and providing this publication, SunGard Higher Education is not rendering legal, accounting, or other similar professional services. SunGard Higher Education makes no claims that an institution’s use of this publication or the software for which it is provided will insure compliance with applicable federal or state laws, rules, or regulations. Each organization should seek legal, accounting and other similar professional services from competent providers of the organization’s own choosing.

Trademark
Without limitation, SunGard, the SunGard logo, Banner, Campus Pipeline, Luminis, PowerCAMPUS, Matrix, and Plus are trademarks or registered trademarks of SunGard Data Systems Inc. or its subsidiaries in the U.S. and other countries. Third-party names and marks referenced herein are trademarks or registered trademarks of their respective owners.

Revision History Log

<table>
<thead>
<tr>
<th>Publication Date</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>April 2008</td>
<td>New version that supports 8.0 software.</td>
</tr>
</tbody>
</table>

Notice of rights
Copyright © SunGard Higher Education <Years of Publication as First, Last>. This document is proprietary and confidential information of SunGard Higher Education Inc. and is not to be copied, reproduced, lent, displayed or distributed, nor used for any purpose other than that for which it is specifically provided without the express written permission of SunGard Higher Education Inc.

Think before you print.
# Table of Contents

**Report Studio** ............................................................................................................4
  - Open Report Studio .................................................................................................. 6
  - The Report Studio Window .......................................................................................9
  - Report Terminology ..................................................................................................11
  - Adding Data to a Report ...........................................................................................12
  - Run the Report ........................................................................................................17
  - Options for Running Reports ...................................................................................18
  - Types of Reports ......................................................................................................19
  - Create Repeated Form Frames from a List ...............................................................23
  - View the Types of Charts ........................................................................................26
  - Create a Chart ........................................................................................................28
Course goal

The goal of this course is to provide you with the knowledge and practice to use the Report Studio in the Cognos 8 Business Intelligence (BI) tool.

Course objectives

In this course you will learn how to

• Open the COGNOS Connection web page.
• Open Report Studio.
• Choose the package for the report
• Create a report.
• Choose a template for the report.
• Add query items to the report.
• Save the report.
• Validate and Run the report.
• Recognize the types of reports.
• Create charts.
**Intended audience**

Report authors for the SunGard Higher Education Banner Performance Reporting and Analytics.

**Prerequisites**

To complete this course, you should have

- a basic understanding of your institution’s business processes and data
- familiarity with producing ad hoc reports using Query Studio. Some exercises in this class build on skills you acquired in the Query Studio class.
Open Report Studio

Introduction

You will use Cognos Report Studio to create several reports. A newly created report contains no data. You will insert data to add content to your report.

Steps

Follow these steps to open Report Studio.

1. At the top right of the Cognos Connection Web Site window, click the Report Studio link.

You should see the Select a package window, similar to the following that contains the packages you can use:
2. Click **Active Registration**

Report Studio will open and you will see a window similar to the following:

![Image of Active Registration window]

3. In the **Welcome** box, click **Create a new report**.

This brings up a box with a list of layout objects you can use to create your report:

![Image of layout objects]

4. Click **List** to select a list report and click OK. You will see a window like the one below:
The Report Studio Window

Introduction

The Report Studio window contains an Insertable Objects pane, a Properties Pane, an Explorer Bar and a Work Area. A toolbar above the panes allows you to carry out many functions by clicking an icon; there is also a menu bar at the top of the window with a variety of Report Studio commands. Following is a description of the areas of the Report Studio window:

Insertable Objects pane

The **Insertable Objects** pane at the top left of the Report Studio window contains objects that you add to your report. There are three tabs in this pane:

- On the **Model** tab are items, such as query items, from the package you are using.
- On the **Query Items** tab is a description (tree diagram) of the queries you are creating in your report.
- On the **Toolbox** tab are other objects you can add to your report like text, calculations, hyperlinks, images, and more.

Properties Pane

The **Properties** pane at the lower left of the Report Studio window lists properties you can apply to a given item in a report. You will work with the **Properties** pane later in this class.
Explorer Bar

The Explorer Bar, the vertical bar at the center of the Report Studio window, contains three buttons:

- The Page Explorer lets you navigate to a specific report page or prompt page.
- The Query Explorer lets you create or change report queries.
- The Condition Explorer lets you work with variables.

Report Studio’s right pane is the Work Area, the space where you create your reports.
Report Terminology

Introduction

Before you begin to use Report Studio, you should understand the terminology associated with its reports. Each report has two aspects:

- A layout
- Queries

The report layout defines your report’s formatting and appearance. Based on your needs, your report can contain objects such as lists, crosstabs, and charts. It can be formatted to include such features as color backgrounds, images, dates, and more. You also have control over how the data appears on multiple-page reports.

The pages in Report Studio contain the objects you include in your report. Each page must have a page body. It can also have a header and footer.

Report queries control the data items in your report. The simplest queries are created by adding report items from the package you are using. However, complex queries can contain filters, calculations, grouping and more. You can change the queries Report Studio creates as well as create custom queries.
Adding Data to a Report

Introduction

The query items you add to your report appear on the **Model tab** of the **Insertable Objects** pane in the Report Studio window. To insert a query item, you can either double-click the item or click the item and drag it into the report. You can use CTRL-click to insert multiple items; items will appear in the order in which you select them. A bold black bar in the work area indicates where you can place query items.

Steps

Follow these steps to create a report that shows the Name of Student and the Academic Year. To do this, you will first add data to your report and save it.

1. In the **Active Registration** package pane, expand the “**Active Registration**” folder by clicking the plus sign.

2. Expand the **Enrollment** folder by clicking the plus sign.

3. Click **Name**

4. Hold down the CTRL key: click **Academic_Year_Desc**, and then **Current_Time_Status_Desc**.
5. Drag the selected items to the work area and release the mouse button when you see the bold black bar.

You will see a window like the one below:

Notice that no data appears in the report yet. You must save and run the report to see the data.

You can obtain information about your report’s structure and the items it contains by selecting some of the other tabs and features in the window:
6. Click the title of the **Name** column.

This produces a list of properties like the one below in the **Properties** pane at the lower-left of the Report Studio window:

Note that this is a partial list; scroll down to see the remaining properties available to apply to the **Name** column.

Note: When you select a property, you will see a description of what it does at the very bottom of the pane. If the description is not visible, select **Property Descriptions** from the **View** menu to see it.
7. In the **Insertable Objects** pane, click the **Data Items** tab to see the structure of the query Report Studio has created from your items:

![Image of Insertable Objects pane]

8. Move the mouse pointer over each of the components of the **Explorer Bar** in the center of the window to see the type of information each provides.
Next, you will save your report.

9. On the **File** menu, click **Save As**. You will see a box like the one below:

![Save As dialog box]

10. In the **Name** field, type your initials followed by Student_List. Click **Save**.
Run the Report

Introduction

After you create a report in Report Studio, you must run it to see the actual data. Report Studio offers a tool to validate the report before you run it to make sure it contains no errors. This will be important when you develop complex reports with features such as calculations.

Steps

Follow these steps to validate the **Student_List** report and then run it to see the data it contains.

1. In the **Student List** report, click the **Validate** icon. You will receive a message that the report is being validated, followed by a box indicating whether the report specification is valid. Click **OK** to close the box.

2. On the toolbar, click the **Run** icon’s down-arrow and select **Run Report (HTML)**. Your results will appear in a separate Report Viewer window like the one below. Note that the window below shows a partial list; scroll down to see the remaining data.

<table>
<thead>
<tr>
<th>NAME</th>
<th>ACADEMIC_YR_DESC</th>
<th>CURRENT_YR_STATUS_DESC</th>
</tr>
</thead>
<tbody>
<tr>
<td>hoax</td>
<td>1994-1996</td>
<td></td>
</tr>
<tr>
<td>Eddy</td>
<td>1995-1996</td>
<td></td>
</tr>
<tr>
<td>Eddy</td>
<td>1995-1996</td>
<td></td>
</tr>
<tr>
<td>Eddy</td>
<td>1995-1996</td>
<td></td>
</tr>
<tr>
<td>Eddy</td>
<td>1995-1996</td>
<td></td>
</tr>
</tbody>
</table>
# Options for Running Reports

## Introduction

In the previous exercise, you have noticed several options for running your report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Report (HTML)</td>
<td>Produces a report in HTML format. If you run your report in HTML, you can</td>
</tr>
<tr>
<td></td>
<td>click the <strong>Run Options</strong> command and type in the <strong>Maximum Rows</strong> box a</td>
</tr>
<tr>
<td></td>
<td>number for the maximum number of rows you want to see on each report page.</td>
</tr>
<tr>
<td>Run Report (PDF)</td>
<td>Use this option when you want to print your report or save a permanent copy.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Adobe Acrobat Reader must be installed on your system for you to run</td>
</tr>
<tr>
<td></td>
<td>your report in PDF format. If you run your report in PDF, you can click the</td>
</tr>
<tr>
<td></td>
<td><strong>Run Options</strong> command to select the output format (PDF), the paper size,</td>
</tr>
<tr>
<td></td>
<td>paper orientation, and language for the report.</td>
</tr>
<tr>
<td>Run Report (XLS)</td>
<td>Use this option to produce a report in Microsoft Excel. For limitations</td>
</tr>
<tr>
<td></td>
<td>associated with this option, see “Producing Reports in Microsoft Excel Format”</td>
</tr>
<tr>
<td></td>
<td>in the Report Studio Help.</td>
</tr>
<tr>
<td>Run Report (CSV)</td>
<td>Use the CSV (comma separated values) option if you want to save your results</td>
</tr>
<tr>
<td></td>
<td>to be opened in an application like Microsoft Excel.</td>
</tr>
<tr>
<td>Run Report (XML)</td>
<td>Use the XML (Extensible Markup Language) option to see an XML representation</td>
</tr>
<tr>
<td></td>
<td>of the queries, prompts, layouts, and styles in your report.</td>
</tr>
</tbody>
</table>

**Note:** You cannot run a report in XML or CSV format if it contains more than one query unless the other queries are used as prompts (prompts will be discussed later in this class). **View Tabular Data** on the **Run** menu allows you to see only the tabular data (for example, to check that your calculations are correct) before you select one of the **Run** options.
Types of Reports

Introduction

You can create three types of reports in Report Studio:

List Report

A list report is a representation of your data in rows and columns and is useful for showing detailed database information. The report you created for Student List beginning in Exercise 2 is a list report. You can manipulate list report data in various ways to obtain the information you need.

Crosstab Report

You can create a crosstab report to show information in summary form. The report still has rows and columns, but the intersection of the rows and columns shows a summary of information.

Charts

You can create a chart to show your information in graphical form. There are several types of graphs you can use in Report Studio. These will be explained later in this class.

Report Studio allows you to combine multiple types of reports in one report.

List Reports

Grouped List Reports

In the previous exercises, you created a list report. You may have noticed duplicate values in the Student List report you just created. For example, each student’s name appears multiple times, once for each year. You can manipulate the report to sort the data and to hide duplicate values through a process called grouping.
Steps

Follow these steps to create a new list report. You will then group two of the report items.

1. On the Report Studio toolbar, click the **New** icon to create a new report. If you are asked if you want to save the previous report, click **Yes**.

2. In the **New** box, select **List** and click **OK**.

3. In the Active Registration Package pan, expand the **Enrollment** folder by clicking the plus sign.

4. Click **Name**.

5. Hold down the **CTRL** key, click **Academic_Year_Desc** and **Academic_Period_Desc**. 
6. Drag the selected items to the work area and release the mouse button when you see the bold black bar.

You will see a window like the one below:

7. On the toolbar, click the Run icon’s down-arrow and select Run Report (HTML). Notice that there are many duplicate values in the report. You can eliminate duplicates by grouping values.

8. In the Report Studio window, click the title of the Name column; hold down the SHIFT key and click the title of the Academic_Year_Desc column to select both columns.

Grouping adds a symbol to the selected columns to indicate that each column is grouped. Your report columns now look like the ones below:

10. Run the report again to see the effect of grouping the columns. Your results will appear in a separate Report Viewer window like the one below.


12. On the Report Studio window File menu, click Save As.

13. In the Save As Name box, type your initials Grouped Student List. Click Save.
Create Repeated Form Frames from a List

Introduction

You can use a list report to create repeated form frames for data. For example, you might want to create labels listing each of your students with an address. To do this, you first create a list report.

Steps

Follow these steps to create a list report and convert it to a repeater (creates a single form frame). You will then set properties for the frame to create multiple frames on each page.

1. On the Report Studio toolbar, click the **New** icon to create a new report. If you are asked if you want to save the previous report, click **Yes**.

2. In the **New** box, select **List** and click **OK**.

3. In the **Active Registration Package**, expand the **Person Address** folder by clicking the plus sign.

4. Click the **Mailing_Formal**.

5. Drag the selected item to the work area and release the mouse button when you see the bold black bar.
6. On the **Structure** menu, click **Convert List to Repeater**. Your report will now contain one form frame and look like the one below:

![Image of converted list to repeater](image)

7. To set the number of form frames to appear on each report page, click anywhere in the background of the frame you have created to bring up its Properties pane:

![Image of properties pane](image)

8. At the top center of the **Properties** pane, click the Ancestor icon and, from the pop-up box, select **Repeater Table**.

9. Under **General** in the **Properties** pane, highlight the number beside Across and type **3**. Then highlight the number beside Down and type **3**.
10. Run the report. You should see a Report Viewer window like the one below with 9 frames per page. Scroll down to see the remaining pages.


12. On the **Report Studio File** menu, click **Save As**.

13. In the **Save As Name** box, type your initials followed by **Student Mailing List**. Click **Save**.
**View the Types of Charts**

**Introduction**

Charts allow you to present your information graphically. Report Studio offers 9 types of charts with multiple configurations for each type. To see the chart types, you can open the New report box in Report Studio and select **Chart**.

Besides being able to create many different types of charts based on Report Studio templates, you can create custom charts that combine chart types. You can also alter the appearance of a chart by changing chart properties to include background images and foreground and background colors. You can also change chart labels and titles. For combination charts, you can control how the data items will appear.

**Steps**

Follow these steps to view the types of charts available in Report Studio and learn how to choose the one most suited to your purposes.

1. On the Report Studio toolbar, click the **New** icon to create a new report. If you are asked if you want to save the previous report, click **No**.

2. In the **New** box, select **Chart** and click **OK**. You will see a window like the one below:
3. Click some of the chart types in the **Chart grouping** pane.

   For each item you select, you will see all the configurations available for that particular chart type in the **Chart type** pane.

4. Click some of the chart configurations in the **Chart type** pane.

   When you select a configuration, you will see the type of chart configuration immediately under **Chart type**. At the same time, you will see an explanation of how the chart will appear and what it is used for.
Create a Chart

Introduction

When you create a chart in Report Studio, you add data to three drop zones. The numbers in the zone boxes show the order in which the items will be added if you double-click them. Alternatively, you can drag items into the zones where you want them to appear. The zones are:

- **Measures**: The numbers (quantitative data) that will be plotted on the Y axis.
- **Categories**: The values that appear on the X axis against which each data series is plotted.
- **Series**: A group of related data points. The data series appear in the chart’s legend, with each series having a different color or pattern. Series is the optional drop zone when you create a chart.

Steps

Follow these steps to create a column chart:

1. In the **Insert Chart** box that you opened in the previous exercise, click the icon for the **Column** chart and click **OK**. You will see a work area pane like the one below:
2. In the Active Registration package pane, expand the **Enrollment** folder. Click **Total_Credits** to select it and drag the selection to the **Measures** drop zone of the chart.

3. Click **Academic_Year_Desc** to select it and drag the selection to the **Categories** drop zone of the chart.

4. Click **Academic_Period_Desc** to select it and drag the selection to the **Series** drop zone of the chart.

5. Run the report to see the chart you have created. Note that **Report Studio** has added labels for the axes and legend as well as the date, page number, and time at the bottom of the page. The chart itself will look like the one below:

![Chart Example](chart-example.png)

6. On the **File** menu, click **Save As**.

7. In the **Save As Name** box, type your initials followed by **Chart Example**.
Release Date

This workbook was last updated on 2/12/2008.